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Notes
(1) No part of this manual may be reproduced in any form without the prior permission of the

publisher.
(2) The contents of this manual, including the specifications, are subject to change without notice

for the purposes of improvement.
(3) This manual was prepared with the utmost care.  However, if you find any ambiguity, errors,

etc., please contact any of our sales offices that are listed at the end of this manual.  When you
do so, be sure to quote the manual number given on the cover of this manual.

Preface

Thank you very much for purchasing the Fuji UG Series Programmable Operation Display.

This manual describes how to use the “variable name cooperation” function with the UG

Series POD connected to the Fuji MICREX-SX Series PLC.  This manual will help you

understand the outline information and to master it efficiently by giving examples in each

chapter.

In addition to this manual, the following manuals on the UG Series are available.  Please

ask your nearest dealer for the appropriate manuals and read them too.

Name Manual No. Contents

UG Series User’s Manual
<Operation>

FEH375 Describes how to operate the screen editor
(UG00S-CW) for the UG Series.

UG Series User’s Manual
<Function>

FEH376 Describes the functions of the UG Series.

UG30 Series User’s Manual
<Hardware>

FEH377 Describes the hardware of the 530/430/330
Series.

UG20 Series User’s Manual
<Hardware>

FEH352 Describes the hardware of the 520/420/320/
220/221 Series.

UG Series User’s Manual
<T-LINK Communications>

FEH356

UG Series User’s Manual
<JPCN-1 Communications>

FEH358

Describes the procedures for
communication with PLCs using the optional
interface unit.

UG Series User’s Manual
<SX-BUS Communications>

FEH357

MICREX-SX Series D300win
<Guide>

FEH250 Describes the basic operation of D300win,
plus the programming and monitoring for the
MICREX-SX series.

MICREX-SX Series D300win
<Reference>

FEH251 Describes the menus and icons of D300win
and all of the operations of D300win.



Matters Calling for Special Attention

The explanation in this manual about the variable name cooperation function applies to the
Ver. 2.20 (2.2.0.0) or newer UG00S-3WE (UG00S-CW).

Use Ver. 1.2.0.0 or newer program-creation system software (D300win) for the MICREX-SX

Series.  When setting up Ver. 2.2.0.0 or a previous version of D300win, enter a check for [POD
cooperated support].   (With Ver. 2.2.1.0 and later versions, POD cooperation support is
installed in the standard installation procedure.)  For details, see “3.1 Setting up D300win”.
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(Recorded as Ver. 2.40)
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With conventional PLCs, memory area is specified by alphabetic characters for area

followed by a number for the memory address.

As a result, PODs have also employed this method to specify areas of PLC internal

memory.

But the MICREX-SX Series uses “label (variable) programming”, which describes the

address part by using what we can imagine as a conventional comment.

When connected to an SX, the POD editor uses a similar method for specifying the

memory areas used for communications between applications, for the program creation

tool for SX (D300win) and for the screen development editor for POD (UG00S-3WE

(CW)).

Using common “variable names” increases the efficiency of PLC programming and

POD screen development.

[Variable Name] Dialog for POD Editor

Same “variable names” are used

for programming or screen

development.

Dialog for Specifying a Variable Name for D300win

Same “variable names” are used

for programming or screen

development.
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General

UG00S-3WE
UG00S-CW

D300win

Global Worksheet

A
B

C

Import/export (*)

(Portable file)

Global Worksheet

A
B

C

Cooperation(1)

Cooperation(2)

Import(3)

Export(4)

Import(5)

Export(6)

Besides directly cooperating the POD editor with D300win, there is another method for

creating programs or developing screens, i.e. using exported or imported intermediate

files (portable files).  The relation between these methods is shown below:

(1) When cooperated

During direct cooperation with D300win ((1) in the above figure), at the moment

new “variable names” are defined by the POD editor, their content is reflected at

D300win.

To enable this method, D300win needs to be activated in advance.  (Both the

D300win and the POD editor must be installed in the same personal computer.)

During cooperation with a “portable file” ((2) in the above figure), at the moment

new “variable names” are defined by the POD editor, their content is reflected in

the portable file.  When the variables are to be used also by D300win, D300win

must import them from the “portable file”.

With this method, screens can be developed even when D300win is not activated.

(2) When not cooperated

During non-cooperation, “variable names” are imported first from D300win or the

“portable file” ((3) and (5) in the above figure) and then a screen is developed.

When “variable names” defined by the POD editor are to be used by D300win,

they need to be exported from the POD editor ((4) and (6) in the above figure).

It is also possible to develop a screen without using (cooperating) “variable

names” defined by D300win at all.

If the operating speed of the editor becomes too slow in the cooperated state, use

the import/export function without cooperation.

Import/export, marked * in the figure above, is operated from D300win.
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Connecting to MICREX-SX
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Connecting method POD editor setting
Model of communications unit

POD side PLC side

UG03I-S, UG02I-S

UG03I-T, UG02I-T

UG03I-J, UG02I-J

--- 

---

UG03I-E (E2)

--- 

NP1L-TL1

NP1L-JP1

NP1L-RS1/2/4

---

NP1L-FL1 (FL2)

Direct connection to 
SX-BUS

Via T-LINK *1

Via OPCN-1 *1

Via RS-232C/485

Direct connection to 
loader port *2

FL-Net *3

Fuji MICREX-SX (SX-BUS)

Fuji MICREX-SX (T-LINK)

Fuji MICREX-SX (OPCN-1)

Fuji MICREX-SX Series

Fuji MICREX-SX CPU

General-purpose FL-Net

Connecting to MICREX-SX

The following methods can be used for connecting to MICREX-SX:

*1 When connected via T-link or OPCN-1, high-speed I/O communication is

possible.  For the setting for I/O communication, see the manuals  “UG Series

<T-LINK Communications>” (FEH356) and “UG Series <OPCN-1

Communications>” (FEH358).

*2 A dedicated cable is required for direct connection to the loader port.

See the manual  “UG30/20 Series <Hardware>” (FEH377, 352).

*3 Only common memory communications are possible with an FL-Net connection,

which means that the variable name cooperation function cannot be used.

See the manual  “UG30/20 Series <FL-Net Communications>” (FEH367).

With the UG400/210 Series, only connection via OPCN-1 is possible.

When using this series, be sure to select a product with an OPCN-1

interface and use NP1L-JP1 at the PLC.
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Precautions Relating to D300Win
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Precautions Relating to D300win

Be sure to use Ver. 1.2.0.0 or a newer version of D300win.

3.1 Setting up D300win

When installing D300win Ver2.2.0.0 or an earlier version, you must select [Custom] in

the [Setup Type] dialog, and then check the [POD cooperated support] box when the

[Select Components] dialog is displayed.

Unless the “POD cooperated support” function is installed, portable files cannot be

imported/exported from/into D300win.  (Neither the [Import Labels] nor the [Export

Labels] command is displayed in the [Extras] menu for D300win.)

With D300win Ver. 2.2.1.0 and later versions, the “POD cooperated support” function

is installed in the standard installation.
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Precautions Relating to D300Win

3.2 What variables can be cooperated?

3.2.1 Type of variable
Be sure to define the memories that access the POD (the memories that need to be

cooperated) as global variables with D300win.  Local variables cannot be cooperated

with the POD editor.

D300win Project Tree

Local variable worksheet

Global variable worksheet

Global variable worksheets whose names

differ from the initial value

“Global_Variables” can also be cooperated.

(In the figure at left, variables in

“Global_POD” can be cooperated.)

However, global variable worksheets cannot

be newly added from the POD editor.

Global variable worksheets can be added or

deleted from D300win.

Sample Content of D300win Global Variable Worksheet

Variables defined on the POD side are

described in the D300win global variable

worksheet, under “VAR_GLOBAL

(*POD_EDITOR*)”, as shown in the

figure at left.

* There is a limit on the number of characters that can be used for variable names.

For more information, refer to “MICREX-SX Series D300win <Instructions>”

(FEH200).
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Precautions Relating to D300Win

3.2.2 AT setting
In principle, “AT” must be set for the memories that access POD (the memories that

need to be cooperated).

Although the variable names, for which “AT” is not set, can be cooperated, the content

of the memories changes each time a variable name is added or deleted or D300win

performs a compilation.

Therefore, on compilation by D300win after screen data has been edited with the POD

editor, there is a discrepancy between the memory content recognized by the POD and

that recognized by the PLC, resulting in abnormal communication.

To avoid this, develop a POD screen without changing the program on the PLC side, or

set “AT”, except when the POD editor is cooperated with D300win, so that any change

of variables on either side can immediately be reflected on the other side.

The memories a POD can access (what areas can be cooperated with) depend on the

type and setting of the connected PLC.

TYPE is used to indirectly specify a memory with a macro of the POD editor.

To indirectly specify a memory with a POD editor macro, the CPU number must be

defined in the extension code.

Input (I) and output (Q) areas cannot be specified indirectly by a macro of the POD

editor.
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Name

Input 
(I)

Output 
(Q)

Standard 
memory 

(M)

Retained 
memory 

(RM)

System 
memory 

(SM)

Type

Bit

Word

Bit

Word

Bit

Word

Bit

Word

Bit

Word

TYPE

-

-

2

4

8

Expression

%IX

%IW

%QX

%QW

%MX
.1

%MW
.1

%MX
.3

%MW
.3

%MX
.10

%MW
.10
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How to Develop a Screen with the Cooperation Function
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How to Develop a Screen with

the Cooperation Function

This chapter describes how to develop a screen by cooperating with a D300win project

or a “portable file”.

This section explains the procedure for cooperating with global variables assuming that

the following global variables are defined in the D300win project.

D300win Screen

Cooperation is performed based on the “variable name”.



4-2

How to Develop a Screen with the Cooperation Function

4.1 Cooperating with a D300win project

4.1.1 Setting the project name
First, variables, which are defined as global variables by D300win, are directly called

from the project and then preparation is made to use them as a POD address.

This method is available only when the POD editor and D300win are simultaneously

activated.

(1) From the main menu, select [File] and then the [Project...] command.

* When developing a new screen, selecting any the items including “SX” (MICREX-

SX T-link/OPCN-1/SX-bus/SX Series/SX CPU) from the [Select PLC Type] dialog

displays the dialog shown in (2) on the next page on the screen.

Select one of these items to proceed to (2).
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(2) The [Setting of Project] dialog appears on the screen.

Click the [Option...] button.
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Uncheck this box for “Ver. 1.xx” of D300win.

Check this box for “Ver. 2.xx” of D300win.

When [Refer...] is clicked to select a file, the extension for the file to be selected

changes depending on whether or not the [V2.* Support] box is checked.

(3) The [Select] (project selection) dialog appears on the screen.

Check the [Cooperating Work] box and then turn on the [D300win Project] optional

button.

(4) Then a project is specified.

In this step, the version of the D300win that is to cooperate is specified.
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When this box is checked, the extension for the file to be selected is “.pwt” (for

Ver. 1.xx of D300win).

When this box is unchecked, the extension for the file to be selected is “.mwt” (for

Ver. 2.xx of D300win).

* When you click the [Refer...] button in this step, the [Select] (file selection) dialog

is displayed.  In this dialog, select the project (.mwt or .pwt) with which you want

to cooperate.

(5) You return to the [Setting of Project] dialog.

Select your desired names for [Configuration Name], [Resource Name] and

[Worksheets] from the corresponding pull-down menus, and click the [OK] button.

(6) If D300win is not activated, activate it and open the specified project.

Do not terminate D300win until the POD editor is terminated.

[Resource] and

[Worksheets] can be

changed when inputting

switches, lamps, data

display or other elements

of POD in the memory.

 See “Page 4-7”.

A new global worksheet cannot be added from the POD.  Be sure to define

global worksheets on the D300win side.
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4.1.2 Using the memories defined by D300win
This paragraph explains how to assign variables defined by D300win to switch

memories.

(1) From the main menu, select [Part] and then the [Switch...] command.

(2) The [Switch] dialog appears on the screen.  Select the [Main] tab, check the [Output

Memory] box, and click the  button.
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(3) The [Memory Input] dialog appears on the screen.  Select “PLC Memory” for

[Type], then click [Name...].  Note that there is no need to specify %IX, %QX, or a

memory number.

* Click [Latest] to update the

D300win information.

Click [Latest] if you have

changed the variable

information at D300win.

(5) The “AT” specification, data “Type” and “Comment” for the variable “Name”

which are set by D300win are automatically input in the corresponding fields.

(4)  Select the [Variable Name] tab, and click the [Name] list button.

A list of the variables defined by D300win is displayed in the pull-down menu.

Select what you want from the list.
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When multiple global worksheets are defined, it is possible to select variables of other

global worksheets while inputting individual switches.

Definition of D300win

Selection Screen for Memory Input

A name can be selected from this

pull-down menu.



4-8

How to Develop a Screen with the Cooperation Function

4.1.3 Defining a new memory from POD
This paragraph explains how to define a memory which does not exist at the D300win

side from the POD.

The memory is defined in the lamp memory for a switch established as described in the

previous paragraph.

(1) Open the [Switch] dialog for the switch established as described in the previous

paragraph.  Then select the [Main] tab, check the [Lamp Memory] box, and click

the  button.

(2) The [Memory Input] dialog appears on the screen.  Select “PLC Memory” for

[Type].
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(3) Set the “AT” specification data (SX No., memory, address) from the pull-down

menu or keyboard.

* The “AT” data may also be specified in the dialog shown in (4) on the next page,

without making a setting here.

To delimit memories, enter “.” (period) from the keyboard.

For input/output memory (%I, %Q), set an SX number; for

auxiliary memory (%M), set a CPU number.

Setting for Input/Output Memory Setting for Auxiliary Memory
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(4) Click the [Name...] button.

Make sure that the “AT” specification made in above (3) is displayed.

To set “AT” here, directly input

data from the keyboard.

(5) Set your desired name in the [Name] box.  Then set [Type] and [Comment], and

check/uncheck the [Retain] box.

To change [Resource] or [Worksheets], select what you want from the pull-down

menu.

For the method for setting data type,  see Chapter 6.
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In the following cases, check the [Retain] box:

(1) The areas for which “%MX (W/D) 3” is set for “AT”

(2) To assign as retained memory without setting “AT”

Precautions when specifying memory with the “AT” setting only

It is possible to specify a memory just by setting “AT” without

assigning a variable name.  Be careful, however, about the following

restrictions on this method:

(1) The specification is not reflected in the global variable

worksheet for the D300win Project.

(2) The type cannot be defined (a data type cannot be selected).

The data type is fixed as “BOOL” when bit data, “WORD” when

word data, and “DWORD” when double-word data.

If you attempt to set a data type other than “WORD” for word

memory when you have only specified “AT”, the following dialog

will appear to disable the setting.
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* When the setting of [Memory Input] dialog is completed, the indication of the

memory part of the [Switch] dialog, and so on will be as follows:

Indication when variable name is

defined

Indication when only “AT” is set

Timing for D300win’s recognition of the variable name defined by POD

When you click [OK] in the [Variable

Name] dialog of the POD (or [OK] in the

[Memory Input] dialog), the variable name

is recognized at D300win.

Global Worksheet for D300win

In the global worksheet for D300win,

the data is described under

“VAR_GLOBAL

(* POD_EDITOR * )” as shown in

the figure at left.
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4.2.1 Setting the project name
Preparation for cooperating with a portable file exported from D300win is described

here.

For the procedure for exporting a file from D300win,  see the User’s Manual

“D300win <Reference>” (FEH251).

When an exported portable file already exists, you do not need to simultaneously

activate D300win.

(1) From the main menu, select [File] and then the [Project...] command.

* To develop a new screen, select one of the items including “SX” (MICREX-SX T-

link/OPCN-1/SX-bus/SX Series/SX CPU) from the [Select PLC Type] dialog to

display the dialog shown in (2) on the next page on the screen.

Select one of these items to proceed to (2).
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4.2 Cooperating with a portable file
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(2) The [Setting of Project] dialog appears on the screen.

Click the [Option...] button.

(3) The [Select] (project selection) dialog appears on the screen.

Check the [Cooperating Work] box and then turn on the [Portable File] optional

button.

Then the location where the portable file exists is selected.  Click the [Refer...]

button to display the [Select] dialog.

In this dialog, specify a file (.ini) to be set as a portable file.

For portable files, the version of D300win

is automatically judged and therefore does

not need to be specified.
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(4) You return to the [Setting of Project] dialog.

Select your desired names for [Configuration Name], [Resource Name] and

[Worksheets] from the corresponding pull-down menus, and click the [OK] button.

4.2.2 Precautions on cooperating with a portable

file
The operation after setting the [Setting of Project] dialog is the same as when

cooperating with a D300win project.

However, the content of the variables defined on the POD side is reflected in the

portable file .  Therefore, for D300win to use such variables, D300win must import

them.

For the procedure for importing variables into D300win,  see the User’s Manual

“D300win <Reference>“  (FEH251).
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Variable definition of D300win Variable definition of POD editor

Variable "Name" Variable "Name""AT" Specification "AT" Specification

AAA

BBB

%MX1.0.0

%MX1.0.1

AAA

CCC

%MX1.10.0

%MX1.0.1

Variable "Name" "AT" Specification

AAA

BBB

CCC

%MX1.0.0

%MX1.0.1

%MX1.0.1

Cooperation is performed based on the variable name.

When cooperating with D300win or a portable file while

developing a screen, if the D300win or the portable file and the

POD editor use the same variable names, their content (“AT”

specification, etc.) on the POD editor side changes.

Variables that have the same “AT” specification but different

names are treated as different variables.

After cooperating, the variable definition of the POD editor becomes as follows:

There is no limit on the number of variable names (the number of variable names

that can be defined in one global worksheet) on the POD editor side.
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C
B

A

C
B

A

C
B

A

Import

Export

Global Worksheet

D300win

UG00S-3WE
UG00S-CW

Global Worksheet

Global Worksheet

(Portable file)

This chapter explains how to develop a screen without cooperating with D300win or a

portable file.  Even when not in the cooperated state, it is possible to capture (import)

the data of variable names into the POD editor and develop a screen based on the data

or to write (export) the data of variable names defined by the POD editor in object files.

It is also possible to develop a screen without cooperating at all.

For this purpose, “AT” must be set.

Developing a Screen without

Cooperation
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Each variable name has “Project Name”, “Configuration Name”, “Resource Name” and

“Worksheets” data.

Therefore, even when a screen is developed without cooperating, these data must be set.

(1) From the main menu, select [File] and then the [Project...] command.

* When developing a new screen, select one of the items including “SX” (MICREX-

SX T-link/OPCN-1/SX-bus/SX Series/SX CPU) from the [Select PLC Type] dialog

to display the dialog shown in (2) below on the screen.

Select one of these items to proceed to (2).

(2) The [Setting of Project] dialog appears on the screen.

Click the [Option...] button.

5.1 Setting the project name
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(3) The [Select] (project selection) dialog appears on the screen.

After confirming that the [Cooperating Work] box is checked, click the [OK]

button.

(4) You return to the [Setting of project] dialog.

If necessary, you can change the project name, configuration name, resource name

or worksheets in this step.  Then click the [OK] button.

* The above names are input as initial values.
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5.2 Importing procedure

This paragraph explains how to capture the data of variable names from D300win or a

portable file.

(1) From the main menu, select [File] and then the [Import...] command.

It is only necessary to specify the version of

D300win when importing from D300win.

Uncheck this box for “Ver. 1.xx” of

D300win.

Check this box for “Ver. 2.xx” of D300win.

(3) Turn on either the [D300win Project] or [Portable File] optional button, and specify

the location where the object files exist with the [Refer...] button.

(2) The [Select] (project selection) dialog appears on the screen.
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(4) When setting is completed, click the [OK] button in the [Select] dialog.

Then, when [D300win Project] is selected, D300win starts to open the specified

project.

(5) The [Import] dialog appears on the screen.

(6) To select a configuration name, a resource name and a worksheet name from those

existing in the file to be imported, check the corresponding boxes in this dialog and

then select your desired names from the pull-down menus.

* If no selection is made, all the content is imported.
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Variable definition of D300win Variable definition of POD editor

Variable "Name" Variable "Name""AT" Specification "AT" Specification

AAA

BBB

%MX1.0.0

%MX1.0.1

AAA

CCC

%MX1.10.0

%MX1.0.1

Variable "Name" "AT" Specification

AAA

BBB

CCC

%MX1.0.0

%MX1.0.1

%MX1.0.1

(7) When setting is completed, click the [OK] button in the [Import] dialog.

When the import is completed normally, the following confirmation dialog appears

on the screen.

Import is performed based on “variable name”.

If D300win or the “Portable file” and the POD editor use the same

“variable names”, their content (“AT” specification, etc.) on the

POD editor side changes.

Variables that have the same “AT” specification but different names

are treated as different variables.

After importing, the variable definition of the POD editor becomes as follows:

There is no limit on the number of variable names (the number of variable names

that can be defined in one global worksheet) on the POD editor side.

The data that can be imported include:

(1) Variable name

(2) Global worksheets name

(3) Data type

When such data have been added or changed by D300win, they must be re-imported.
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5.3 Exporting procedure

This paragraph explains how to write the data of variable names defined by POD into

D300win or a portable file.

(1) From the main menu, select [File] and then the [Export...] command.

(2) The [Select] (project selection) dialog appears on the screen.

(3) Turn on either the [D300win Project] or [Portable File] optional button, and specify

the location where the object file exists with the [Refer...] button.

When exporting to D300win, it is

necessary to specify the version of

D300win.

When exporting to an already existing

portable file, the version of D300win is

automatically judged and therefore does

not need to be specified.

* When exporting to a new portable file, the following confirmation message is

displayed.
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(4) When setting is completed, click the [OK] button in the [Select] dialog.

Then, when [D300win Project] is selected, D300win starts to open the specified

project.

(5) The [Export] dialog appears on the screen.

(6) To select a configuration name, a resource name and a worksheet name from those

existing in the file to be exported, check the corresponding boxes in this dialog and

then select your desired name from the pull-down menus.

When no selection is made, all the content is

exported.

* When you want to export to a new portable file, select the version of D300win in

this step.

[Yes]: Data is exported in the format for “Ver. 2” of D300win.

[No]: Data is exported in the format for “Ver. 1” of D300win.
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Variable definition of D300win Variable definition of POD editor

Variable "Name" Variable "Name""AT" Specification "AT" Specification

AAA

BBB

%MX1.0.0

%MX1.0.1

AAA

CCC

%MX1.10.0

%MX1.0.1

Variable "Name" "AT" Specification

AAA

BBB

CCC

%MX1.10.0

%MX1.0.1

%MX1.0.1

(7) When setting is completed, click the [OK] button in the [Export] dialog.

When the exported is completed normally, the following confirmation message

appears on the screen.

Export is performed based on the variable name.

If D300win or the portable file and the POD editor use the same

variable names, their content (“AT” specification, etc.) on the POD

editor side changes.

Variables that have the same “AT” specification but different names

are treated as different variables.

After export, the variable definition of the POD editor becomes as follows:

Variables that are assigned no name and for which only “AT” is set by the POD

editor cannot be exported.
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5.4 Developing a screen with the unit POD editor only

Even when a screen is developed without cooperation, it is necessary to set the project

name and other data.

For the setting procedure,  see “5.1 Setting project name”.

Screen data that is created without cooperation, or by importing, needs to be compiled

before being transferred.

How to Compile the Data

Click the [All compiling...] command in the [Tool] menu.

When input/output memory (%I/%Q) is used, be sure to cooperate

with D300win or a portable file.

Unless system configuration data (input/output configuration data)

is captured into the POD editor from D300win or a portable file, an

error occurs while the POD editor is compiling the data, and the

system cannot operate normally.

With UG editors older than Ver. 2.4.0.0, if I and Q for the modules

that are not included in the system definition (“No equipment”) are

used in the POD screen data, an error occurs during compilation.

With a Ver. 2.4.0.0 or later UG editor, the system operates

normally.

When multiple resources are defined, you are recommended to

input a CPU number when specifying memory.

If the CPU number setting is omitted, it is regarded as 0 (zero).

Be sure to specify “AT” when a variable name is defined with a

POD editor.
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Data Type

This chapter explains how to set the data types supported by the MICREX-SX Series so

that the POD can deal with them.

6.1 BOOL type

BOOL type is the smallest unit of data that can be expressed by one bit (0 or 1).

For the display elements of POD, such

as switches and lamps, which are

accessed by the bit, the BOOL type

must be selected.

6.2 INT/DINT type

The INT (integer) type requires 16-bit

(single-word) memory space to deal

with integral values from -32768 to

32767.

The DINT (double-precision integer)

type requires 32-bit (double-word)

memory space to deal with integral

values from -2147483648 to

2147483647.
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For Numeric Display

Turn on the [DEC] optional button in

the [Input Type] box.

In the [Data Length] box, turn on the

[1-Word] optional button when INT

type is selected or the [2-Word]

optional button when DINT type is

selected.

For [Display Type], select either “DEC

(w/o sign)” or “DEC (w/+sign)”.

When Type such as Read Area is not Set

For memory for which input type,

(such as read/write area or graphic

memory) is not specified, the setting of

[Code] in the [Detail] tab of the

[Comm. Parameter] dialog under

[System Setting] is applied.

For MICREX-SX, because the initial

setting is “DEC”, the data type must be

INT (DINT when 2-word numeric

values are used).
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6.3 UINT/UDINT type

UINT (unsigned integer) type

requires 16-bit (single-word)

memory space to deal with integral

values from 0 to 65535.

UDINT (unsigned double-precision

integer) type requires 32-bit

(double-word) memory space to

deal with integral values from 0 to

4294967295.

For Numeric Display

Turn on the [DEC] optional button

in the [Input Type] box.

In the [Data Length] box, turn on

the [1-Word] optional button when

UINT type is selected; turn on the

[2-Word] optional button when

UDINT type is selected.

For [Display Type], select “DEC

(w/o sign)”.
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A single unit of WORD (16-bit string)

type data has a size equal to 16 BOOL

type data (16 bits). An individual bit

expresses 1 or 0 when turned on or off.

(0 to FFFF)

A single unit of DWORD (32-bit

string) type data has a size equal to 32

BOOL type data (32 bits).  An

individual bit expresses 1 or 0 when

turned on or off.  (0 to FFFFFFFF)

For Numeric Display

In the [Data Length] box, turn on the

[1-Word] optional button when

WORD type is selected;

turn on the [2-Word] optional button

when DWORD is selected.

6.4 WORD/DWORD type

For [Display Type], select “HEX”.

* When “HEX” is selected for

[Display Type], [Input Type] is

disabled.
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6.5 Derived data types

It is not possible to make a new definition for derived data type (“array” or

“structured”) at the POD editor side.

To use this data type, capture the data type information by cooperating with D300win

or a portable file, or by importing.

In this paragraph, it is supposed that the following definitions have been set at the

D300win side.

Data Type Definition

Global Variable Definition
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6.5.1 “Array”
(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG array”.

(2) Click the [Element] tab.

From the [Element] list box, select your desired data type.

(3) Set an element number for the “UG array”.
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(4) Click the [OK] button.  The indication for the memory part will be as follows:

6.5.2 “Structured”
(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG structured”.

(2) Click the [Element] tab.

From the [Element] list box, select your desired member name.
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(3) Click the [OK] button.  The indication for the memory part will be as follows:

6.5.3 “Array of Array”
The setting method when one of the elements of an “array” is an “array” is explained

below.

(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG array of array”.

(2) Click the [Element] tab.
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1

2

3

4

5

6

7

8

9

10

2 3

* This paragraph explains the setting method by taking the data defined below as an

example.

← To access this, specify “UG array of

array” [3][5].

The procedure for setting “UG array

of array” [3][5] is explained below:

(3) From the [Element] list box, select the first data type (in the range from 1 to 3 in

this case).
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(4) Specify an element number in the “array”.

(5) Then, from the [Element] list box, select the next data type (in the range from 1 to

10 in this case).

(6) Specify an element number in the “array”.
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(7) Click the [OK] button.  The indication of the memory part will be as follows:

6.5.4 “Structured of Array”
The setting method when one of the members of a “structured” is an “array” is

explained below.

(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG structured of array”.

(2) Click the [Element] tab.
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(3) From the [Element] list box, select the member which is defined as an “array”

(DATA6 in this case).

(4) Then, select the data type part in the “array”, and specify an element number.

(5) Click the [OK] button.  The indication for the memory part will be as follows:
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6.5.5 “Array of Structured”
The setting method when one of the elements of an “array” is a “structured” is

explained below.

(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG array of structured”.

(2) Click the [Element] tab.

(3) From the [Element] list box, select the data type part, and specify an element

number.
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(4) Then select the member that is a “structured”.

(5) Click the [OK] button.  The indication for the memory part will be as follows:
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6.5.6 “Structured of Structured”
The setting method when one of the members of a “structured” is a “structured” is

explained below.

(1) From the [Variable Name] tab of the [Memory Input] dialog, select a variable name

with the definition “UG structured of structured”.

(2) From the [Element] list box, select the member name which is defined as a

“structured” (DATA6 in this case).

(3) Select a member name of the “structured” which was selected in (2) above.
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(4) Click the [OK] button.  The indication for the memory part will be as follows:
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6.6 TIME type

The TIME (continuous time) type requires 32-bit

(2-word) memory space to deal with numeric

values from 0 to 4294967295.

* In the PLC, the unit is ms.

Remember this when setting numeric values

from the POD.

For Numeric Display

In the [Input Type] box, turn on the

[DEC] optional button.

In the [Data Length] box, turn on

the [2-Word] optional button.

Select “DEC (w/o sign)” from the

[Display Type] list box.
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The REAL type uses 32-bit memory space to deal

with real numbers in the range from ±2–126 to ±2128

including 0 (zero).  The accuracy guarantee range on

the POD side is 7 significant digits.

Note: Exponential expressions, such as “1.23E +3”,

are possible on the SX side but not at the

POD side.  On the POD side, this value is

displayed in the normal format, as “1.23”.

For Numeric Display

Set “FLOAT” for [Input

Type].

[Data Length] is fixed as

“2-Word”.

6.7 REAL type

* The position of the

decimal point on

the POD screen is

specified by this

entry.
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Available devices

Internal 
memory

PLC 
memory

W word
Indirect 

designation
Memory 

card
Constant

F0

F1

F2

CVFD: Real-to-decimal conversion F0 (D) < -F1 (F) F2

R
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Available devices

F0

F1

F2

Internal 
memory

PLC 
memory

W word
Indirect 

designation
Memory 

card
Constant

CVDF: Decimal-to-real conversion F0 (F) < -F1 (D) F2

Only the items for [Num. Display] (numeric display) explained on the

preceding page can be displayed in the REAL type (with real numbers).

When real values are used for other items (graphs and sampling), it is

necessary to convert real numbers into decimal numbers, or vice versa, using

the following newly added macro commands.

CVFD

This function converts the real number of F1 into a decimal number,

using the conversion scale of F2, and writes the converted value in F0.

The conversion scale is –32 to +32.

CVDF

This function converts the decimal number of F1 into a real number,

using the conversion scale of F2, and writes the converted value in F0.

Conversion scale is –32 to +32.

[Example]

For the following CVFD command,

$u00010 (D) < -$u00000 (F)  10

When $u00000 = 0.0001234567, then

$u00010 becomes “1234567”.
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6.8 DATE, TOD and DT types

The DATE, TOD and DT types, which are dealt with as time data on the SX side, are

dealt with in “time display” mode on the POD side.

The AT specification for DATE, TOD and

DT types must be double-word (32-bit).

Time Display Setting

Set [Calendar Condition] according

to the data type, as follows:

DATE type: Date only

TOD type: Time only

DT type: Date and time

To display time data by

DATE, TOD or DT type,

select “Calendar Display” for

[Display Mode].  Uncheck the

[Use System Calendar] box.

Uncheck the [Specify Format] box in the [Time

Display Format] dialog under [System Setting].



6-21

6

Data Type

STR
IN

G
 typ

e

The STRING type is Fuji Electric’s unique code

that was developed based on Shift JIS code.

On the UG side, the number of characters that can

be displayed on one screen changes according to

the screen size or character size, but on the SX

side, the maximum number of characters is fixed

as 64 for STRING type.  This must be taken into

consideration when you set the number of bytes.

For SX, the set number of bytes is equal to the

number of display characters.

String Display Setting

On the [Type] tab window,

check the [Use STRING Type]

box.

6.9 STRING type
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Variable Name Cooperation

Function of POD Editor

This chapter describes the functions that become available when the variable name

cooperation function is used.

7.1 Variable name list

This function displays the current status of the variable name cooperation function.

From this list, you can batch change configurations, resources or worksheets and

perform other operations.

(1) From the main menu, select [Tool] and then the [Variables List] command.

(2) A list of variable names is displayed.
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7.1.1 Contents of the list window

(1) Tree display section (left side of the window)

(1) Project name

(2) Configuration name

(3) Resource name

(4) Global worksheet name

Projects, configurations, resources and global worksheets are displayed in a tree

structure.

When any other global worksheet name is clicked, the variable names listed on the right

side change.

(2) variable name display section (right side of the window)

(1) Tree display section

(2) Variable name display section

The variable names are listed, and are registered in the global worksheet currently

selected in the left side of the window.

(1) (2) (3) (4) (5) (6)
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(1) Variable Name

Variable names that are used are displayed.  The icons displayed in front of the

variable name have following meanings:

 : Linked to the project or a portable file and used in the screen data.

 : Linked to the project or a portable file but not used yet in the screen data.

 : Linked to the “RETAIN” memory for the project or a portable file and used

in the screen data.

 : Linked to the “RETAIN” memory for the project or a portable file but not

used yet in the screen data.

 : Not linked to the project or a portable file but used in the screen data.

 : Not linked to the project or a portable file and not used yet in the screen

data.

It is possible to set non-display of the icons.  For details,  see “7.1.2 Changing

the mode of variable name list display”.

(2) AT

The memories (with “AT” specification) to which variables are assigned are listed

here.

When only “AT” is set without assigning a variable name, this column becomes

blank, and the content of the “AT” specification is displayed in the [Variable Name]

column in (1) above .

(3) Data Type

The data types of the variables are displayed here.

(4) Comment

When defined, comments for the variables are displayed here.

(5) State

The state of the variables is displayed here.

(6) Compile

The result of compilation performed on the POD editor is displayed here.  When

not yet compiled, “--” is displayed.
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7.1.2 Changing the mode of the variable name

list display
The mode of the variable name list display can be changed as follows.

With the variable name list is displayed, click [Display] in the main menu.

Click (check) the item you want.

When [Not Display the Icon] is checked, no icon is displayed in front of the variable

names.

No icon is displayed.

7.1.3 Copying, moving and deleting a variable

name
From the variable name list, it is possible to copy or move variables between global

worksheets or to delete them from a global worksheet.

(1) Select the variable name you want to copy, move or delete, and click the operation

command in the [Edit] menu.

Select an operation.

Multiple variable names can

be selected by using the

[Shift] or [Ctrl] key.
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(2) Click the target global worksheet name and then the operation command in the

[Edit] menu.

Select an operation.

* In the state of cooperation with the project or a portable file, clicking the [Cut] or

[Delete] command displays the following confirmation dialog, asking you whether

or not to perform the operation on the variables in the cooperated object.

This confirmation dialog is displayed only when [No Inquiry] is unchecked in the

[Cooperate Option] command in the [Tool] menu.

The initial setting is “uncheck”.

 See “7.1.7 Cooperate option”.
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7.1.4 Variable name replace and find functions
A variable name, “AT” specification, data type and comment can be replaced or found

from the list screen.

The object for both “find” and “replace” is the currently selected global worksheet.

(1) With the variable name list displayed, click the [Find] or [Replace] command in the

[Edit] menu.

(2)-1 Find

The [Find] dialog appears on the screen.  Input the character string for which you

want to find the worksheet.

Match whole word only: When this box is checked, the words that completely

coincide with the input character string are found.

When unchecked, the words that include the input

character string are found.

(2)-2 Replace

The [Replace] dialog appears on the screen.  Input the character string to be

searched for as well as the character string to replace the ones found.

Match whole word only: When this box is checked, the words that completely

coincide with the input character string are found.

When unchecked, the words that include the input

character string are found.

* In the state of cooperation with the project or a portable file, a confirmation dialog

asking you whether or not to also replace the variable names in the cooperated

object is displayed.   See “Page 7-5”.
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7.1.5 Batch change of configurations, resources

and worksheets
The configuration, resource and worksheet names can be changed from the list screen.

This operation is disabled in the state of cooperation with a project or a portable file.

(1) In the tree display section (left side) of the [Variable Name List] window, double-

click the configuration name, resource name or worksheet name you want to

change.

(2) It is now possible to rename the configuration, resource or worksheet.  Input your

desired name and press the RETURN key.

(3) The object variable is changed.
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7.1.6 Comparison of variables
It is possible to compare the variables in the POD data currently being created with

those in the project or the portable file from the list screen.

In the state of cooperation with a project or a portable file, this function is disabled

because the variable content of the POD data and the project or the portable file always

coincides.

(1) With the variable name list displayed, click the [Comparison D300win] command

in the [Tool] menu.

(2) The [Select] dialog box appears on the screen.  Select [D300win Project] or

[Portable File] in relation to which the comparison of variables is to be performed.

The moment [D300win Project] is selected, D300win starts.

(3) Icons for the result of the comparison are displayed as shown below.
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Icon State

Same

Different/UG data

Used only by UG

Different/D300win

Content of the variable coincides between POD editor and 
D300win.

Both POD editor and D300win use the variable, but its content 
does not coincide between them.

The variable is used not by D300win but by POD editor. 

Both POD editor and D300win use the variable, but its content 
does not coincide between them.

Description

OK

ERR

D300

The icons displayed in front of variable names and the statement displayed in the

[State] column have the following meanings:

“ ERR : Different /UG data” and “ D300 : Different/D300win” are displayed in pairs.

For “ ERR : Different/UG data”, the definition on the POD editor side is displayed.

For “ D300 : Different/D300win”, the definition on the D300win side is displayed.

7.1.7 Cooperation option
This function defines the operation that is used when variable names are cooperated.

With the variable name list displayed, click the [Cooperation Option] command in the

[Tool] menu.

[Renew the Project] : .............. When a variable is deleted, cut or pasted with this

command and the [No Inquiry] command both checked

in cooperation mode, the content is also reflected in the

cooperated object.

[No Inquiry] : .......................... When this item is checked, the confirmation dialog does

not appear on the screen even when a variable is

deleted, cut, pasted or replaced.

[Cooperating Work] : ............. Changeover between the cooperation and un-

cooperation modes for a project that is set by the

[Option] in the [Project] command in the [File] menu.

In the cooperated state, this item is checked.

[Cooperate mainly with AT] : Enabled in cooperation mode.  Normally, cooperation is

performed based on the variable name.  When this item

is checked, cooperation is performed based on the “AT”

specification.
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To transfer screen data, several items related to a variable name need to be set.

7.2.1 Download
To download screen data (from a personal computer to POD), you must specify

whether or not the variable names data is to be stored in the POD.

(1) Click [Unit Setting...] command in the [System Setting] menu.

(2) The [Unit Setting] dialog will appear on the screen.  Click the [Environment

Setting] tab.

7.2 Screen data transfer
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(3) When the [Transfer Variable Table] box is checked, the data of variable names is

transferred to the POD at the moment screen data is downloaded.

Normally, when screen data is downloaded, this item should be checked

so that the data of variable names is transferred to the POD.

When this box is unchecked, be sure to save the screen data files.

If uploaded without checking this item or saving the screen data file, the

content of variables and “AT” specification cannot be displayed

correctly.

For details,  see “7.2.2 Upload”.

When variable names are transferred, the total quantity of screen data for

the variable names increases.

The total quantity of screen data can be checked with the [Memory Use]

command in the [Tool] menu.
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7.2.2 Upload
The procedure for uploading (from POD to the personal computer) the screen data

using the variable name cooperation function differs depending on whether or not the

variable names data was stored in the POD when the screen data was downloaded.

(1) Click the [Transfer...] command in the [File] menu.

(2) The [Transfer] dialog appears on the screen.

If the variable names data was stored in the POD when the screen data was

downloaded, clicking the [PC <-] button uploads the data and the memory content is

displayed correctly.



7-13

7

Variable Name Cooperation Function of POD Editor

Sc
re

e
n

 d
a

ta
 tra

n
sfe

r

If the screen data was downloaded without storing the variable names data in the POD,

check the [Read Valiables in Data Transfer] box.

Clicking the [PC <-] button uploads the data, and the [Look in:] dialog box appears on

the screen.  In this dialog, select the original screen data file.

If uploaded when neither the variable names data nor the original screen

data is present in the POD, the memory content is not displayed

correctly.

7.2.3 Precautions on online editing
During online editing, the variable names data stored in the POD is not updated.

When the [Transfer Variable Table] box is checked in the [Environment Setting] tab

window of the [Unit Setting] dialog under [System Setting], the data of the variable

name is transferred at the moment online editing ends.
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Precautions on Using the Variable

Name Cooperation Function

This chapter explains matters that require special attention when using the variable

name cooperation function.

8.1 Memory display

This function is used to check the memory assignment for the switch lamps and other

parts laid out on the screen; they are displayed by specifying variables or addresses.

(1) From the main menu, select [Display] and the [Display Environment...] command.

(2) The [Display Environment] dialog

appears on the screen.  On the [Detail]

tab, check the [Memory] box.  Then it

becomes possible to select either [AT]

(direct address) or [Variable].  Select

one of these then press the [OK] button

to display the parts on the edit screen

with their addresses indicated on them.

When [Variable] is selected When [AT] is selected
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8.2 Memory increment

The memory increment function for multiple copying of an item or for tabular data

normally operates based on the variable name data.  When only “AT” is specified

without assigning a variable name, this function operates based on the “AT”

specification.

This function is explained below, using multiple copying as an example.

(1) Suppose a switch and a lamp are set on the screen, as shown below.

(2) Select the switch, and click the [Multi Copy] command in the [Edit] menu.

The [Multiple Copy] dialog appears on the screen.  Make the following settings in

this dialog, then click the [OK] button.
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(3) The switch is copied as follows:

* Because the variable name “POD2” is

already assigned to “%MX0.1.2” of the

lamp.

When a variable name and “AT” are set for the copy destination, the content is

reflected.

When there are no definitions for the destination, only the “AT” specification is

reflected.

For “array” and “structured”, the memory increment function is disabled.
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8.3 Memory batch change

Memory batch change is performed based on the “AT” specification.

CPU numbers can also be changed in a batch with this function.

The procedure is shown below:

(1) Suppose the following switches are set on the screen.

* The display when [Memory] and

[Variable Name] are selected in

the [Detail] tab of the [Display

Environment] dialog for the

editor.

For details,  see “8.1 Memory

display”.

Variable Name: POD10

AT: %MX1.10.0

Variable Name: POD11

AT: %MX1.10.1

Variable Name: none

AT: %MX1.10.2

Variable Name: POD13

AT: %MX1.10.3

It is also supposed that the following variable names and “AT” specification are set:

Variable Name: POD20

AT: %MX1.20.0

Variable Name: POD22

AT: %MX1.20.2

(2) Select [Tool], [Change Memory] and then the [Change All Memory] command.
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(3) The [Change All Memory] dialog appears on the screen.  Check the [0] (zero) box,

and set each item.

Either variable name or “AT” can be set for [Before Change Start Mem. No.] and

[After Change Start Mem. No.] (the same as in the normal procedure for specifying

a memory).

However, the content of the pull-down menu for the variable name changes with the

“Bit/Word” type.

Only “AT” can be set for [Before Change End Mem. No.] (even when a variable

name is assigned).  Set “AT” on the [Memory Input] tab.

(4) In this example, these items are set as follows:

(5) The screen data is changed as follows:

When both variable name and “AT” are set for the destination, their content is

reflected.  When there are no definitions for the destination, only the “AT”

specification is reflected.

For “array” and “structured”, the memory batch change function is disabled.
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When screen data is saved, the following files are created:

(1) [File Name].U3 (or U2) ........ Screen data file

(2) [File Name].env .................... Screen data creating environment file

(3) [File Name].ldt ..................... Variable name cooperation file

(4) [File Name].ldc .................... Variable name cooperation file

(5) [File Name].bak .................... Screen data backup file (may not be created

depending on the setting of the editor)

Files (3) and (4) are created only when the variable name cooperation function is used.

Note that only file types (3) and (4) are not objects of the “File Divide” and “File

Combine” operations under [File Managing] in the [File] menu.

* For copying (including the copying of screen data files), variables in the destination

become the object.

When copying, moving or deleting screen data using Windows

operations (using Explorer, for example) at the personal computer, be

sure to perform operations on the data of (1), (3) and (4) above together.

8.4 Screen data files
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The figure below shows a sample display on the simulator.

When both variable name and “AT” are set, the variable name and “AT”

specification are displayed in this order.

When only “AT” is set, only the “AT” specification is displayed.

* Precautions on adding or inserting a memory

Memory is added or inserted by setting “AT” (variable names cannot be used).

Input/output memory (%I/%Q) cannot be added or inserted.
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8.5 Precautions on using the simulator
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Because cooperation is performed based on the “AT” specification

when a Ver. 2.10 or older POD editor is used but based on a variable

name when a Ver. 2.20 or newer POD editor is used, if the screen data

created with a Ver. 2.10 or older POD editor is read with a Ver. 2.20

or newer POD editor, cooperation with D300win or a portable file

may be impossible.

If cooperation is not

possible, display the

variable name list and click

[Cooperate mainly with AT]

in the [Cooperation Option]

command in the [Tool]

menu.

8.6 Compatibility of POD screen data between new and old versions

Screen data created by Ver 2.10 or older POD editor consist of the following files:

(1) [File Name].U2 .................... Screen data file

(2) [File Name].env .................... Screen data creating environment file

(3) [File Name].ldb .................... Variable name cooperation file

(4) [File Name].bak .................... Screen data backup file (may not be created

depending on the setting of the editor)

When screen data created with Ver. 2.10 or an older POD editor is read and saved with

Ver. 2.20 or a newer POD editor, the saved data is of the new data type explained on

page 8-6.

Note, however, that Ver. 2.10 or older POD editor cannot normally read the screen data

of the new data type.
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: Can cooperate
: Cannot cooperate

POD editor
Ver 2.2.1.0 or 
older

POD editor
Ver 2.3.0.0 or 
later

D300win Ver 1.xx D300win Ver 2.xx

* *

* The version of D300win needs to be specified when 
the cooperation with POD editor is set.  For details, 
refer to page 4-3.

: Can cooperate
: Cannot cooperate

Version of D300win from 
which file is exported

Version of POD editor

Ver 1.2.0.0 
or older

Ver 1.2.0.0 Ver 2.xx

Ver 2.1.5.0 or older

Ver 2.3.0.0 or later

Ver 2.2.0.0, Ver 2.2.1.0
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8.7 Combination with D300win versions

8.7.1 D300win projects
The following combinations are available between D300win projects and the UG

editor.

8.7.2 Portable file
When cooperating with a portable file exported from D300win, the following

combinations are available:
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